The Start screen

The Start screen is the new face of Windows. It’s made up of a grid of colorful tiles, one for each app. Click a tile to run its app. You’ll see tiles for a slew of new, lightweight apps built into Windows 8 as well as traditional applications like Microsoft Word. Even the Windows Desktop is accessed via a tile.

Some apps grab real-time information (such as upcoming events in your calendar) and display it as notifications on their tiles.

The new Charms bar on the right gives you quick access to search, system settings and more, and you’ll use the scroll bar at the bottom to reach tiles that are located off the right edge of the screen.
The Desktop

No longer front and center, the Desktop is reached by clicking the Desktop tile on the Start screen. When you get there, you’ll see a visually simpler, flatter interface than in Windows 7. And one major navigational feature, the Start button, has been removed.

Otherwise, it behaves pretty much like the Windows 7 Desktop, with icons for launching your traditional Desktop applications and a taskbar that shows currently running apps. Note, however, that you can’t run the new Windows 8 apps from the Desktop.
Windows 8 Mouse & Keyboard Shortcuts

Open the Start screen. The colorful rectangular tiles that make up the new Start screen are easy to reach.

Touch screen: Swipe your finger into the screen from the right border to make the Charms panel appear (described next); tap Start.

Mouse: Point to the lower-left corner of the screen; when the Start screen icon appears, click.

Keyboard: Press the Windows key.

Many new tablets and laptops have a dedicated Windows-logo button under the screen. Pressing it also opens the Start screen.

Open the Charms panel. The Charms menu is a thin vertical panel of important icons like Search, Share, Start and Settings.

Touch screen: Swipe your finger into the screen from the right border.

Mouse: Point to the top right corner of the screen.

Keyboard: Press the Windows key+C.

You can also jump directly to one of the buttons on the Charms panel.

Share button: Windows+H

Settings button: Windows+I

Devices button: Windows + K

Open the App menu. Programs designed for TileWorld often have a few options, represented as icons in a hidden horizontal bar. In Internet Explorer, for example, this bar shows all your open browser tabs.

Touch screen: Swipe into the screen a short distance from the top or bottom of the screen.

Mouse: Right click anywhere in the window.

Keyboard: Press the Windows key+Z.
Windows 8 Shortcuts (continued)

Next app. Here's how you jump from one TileWorld app to the next. (The Desktop, and all of its own programs, are represented as one jump.)

**Touch screen:** Swipe into the screen from the left border.

**Mouse:** Point to the upper left corner of the screen.

**Keyboard:** Press and release the Windows key+Tab.

App Switcher. In regular Windows, Alt+Tab (and hold down the Alt key) shows you a little dashboard displaying the icons of all open programs, so you can jump directly to the one you want.

**Touch screen:** Swipe into the screen from the left border, then back out again. A vertical column of open app icons appears.

**Mouse:** Point to the lower left corner of the screen.

**Keyboard:** Press Windows key+Tab, but keep the Windows key pressed.

*Or press Alt+Tab (hold down Alt) as you always have. That brings up the traditional horizontal row of open-app icons. This app switcher includes open desktop apps (traditional Windows apps).*

Split the screen between two apps. This feature made its debut with Windows 7; it lets you split your screen between two programs’ windows.

**Touch screen:** Swipe your finger slowly into the screen from the left or right border. Or swipe down from the top edge, then to right or left.

**Mouse:** Drag a window's title window to the left or right side of the screen until its outline changes to a full-height, half-width window. Release.

**Keyboard:** Press Windows key plus the left or right arrow key.

Close an app. Here's how to exit a program in TileWorld.

**Touch screen:** Swipe down from the middle of the top border, almost all the way down the screen.

**Mouse:** Point to the top of the window to make the grabber handle appear; drag it all the way down the screen.

**Keyboard:** Press Alt+F4.
Windows 8 Shortcuts (continued)

Right click. In Windows, right clicking an item summons a shortcut menu — a short menu listing commands relevant only to the object you clicked. In Windows 8, that menu takes the form of a horizontal strip at the bottom of the Start screen, offering options like Uninstall and Unpin (from the Start screen).

**Touch screen:** Swipe down from a tile on the Start screen.

**Mouse:** Right click, of course.

**Keyboard:** Press the little menu key.

Zooming in or out. To magnify or shrink your view of a photo, map or Web page, proceed like this:

**Touch screen:** Spread or pinch two fingers on the screen, just as on an iPad.

**Mouse:** While pressing the Ctrl key, turn your mouse's scroll wheel.

**Keyboard:** Press Ctrl and the + or – key.

*Zooming fully out. On the Start screen, you can zoom out so far that your tiles become little icons; in this mode, you can group them or move them en masse.*

**Touch screen:** Pinch two fingers on the screen.

**Mouse:** While pressing the Ctrl key, turn your scroll wheel. Or point to the bottom right, and then click the Summary View icon that appears. (To zoom out again, click any blank area.)

**Keyboard:** Press Ctrl+the minus key.

*Search for files or settings. The new TileWorld Search command requires that you specify what you’re looking for: an app, a file and so on. But there are shortcuts for file searches and settings searches.*

**Touch screen:** Swipe in from the right border; tap Search; tap Files or Settings.

**Mouse:** Point to the top right corner of the screen; tap Search; tap Files or Settings.

**Keyboard:** Press the Windows key+F for files, Windows key+Q for settings.

*Search for apps. This one’s really best with the keyboard: you can jump to an app on the Start screen, even if it’s several horizontal scroll-pages away.*

**Touch screen:** Swipe in from the right border; tap Search.

**Mouse:** Point to the top right corner of the screen; tap Search.

**Keyboard:** At the Start screen, just start typing.
External monitor/projector options. Do you want your main screen mirrored on the external screen, or extended onto it? You can open a handy panel that lists your options.

**Touch screen:** Swipe in from the right border; tap Devices; tap Second Screen.

**Mouse:** Point to the top right corner of the screen; tap Devices; tap Second Screen.

**Keyboard:** Press Windows key+P.
Office 2013

At the suite's core is Office 2013—the desktop applications. Changes include a sleek appearance that reflects the look of Windows 8, functional improvements and tie-ins to SharePoint and SkyDrive for storing documents online.

In addition, the various components of Office Web Apps improve productivity in the cloud, while Windows 8 Surface RT tablets get their own flavor of Office.

Modern Style Interface

In keeping with the “Modern” (previously called “Metro”) style interface that you’ll see in Windows 8, Office 2013 is getting a new look. Gone are the multiple shades of color that decorated the older interface, as well as the shadows and shading that suggested three dimensions. Instead, everything is minimalist, flat and stark — mimicking the tiles on the Windows 8 start screen. The only hint of frivolity exists in a watermark design in the top right corner of the screen. The idea is that the new look will help you focus on your work rather than being distracted by the objects decorating your screen. Whether the redesign will achieve this goal or not—time will tell one way or the other. It's not a major departure from Office 2013, so the new look just takes some getting used to.
Start Screens

Each app supports a new color-coded start screen—blue for Word, green for Excel, orange for PowerPoint, green for Publisher. Like the other applications’ start screens, the one for Word displays a list of recent documents. Though creating a blank document is the default option, you can alternatively select a template, search online for templates or click Open Other Documents to search for a document on disk or in a SkyDrive folder. These screens will help new users find their way around more easily, and experienced users will appreciate having all of their options in one place at startup. The top right of the screen shows details of the SkyDrive account that you are currently logged in to use.
SkyDrive Integration

Office 2013 is designed to integrate with the cloud -- with SkyDrive and SharePoint, in particular. That’s good news if you prefer to save your work online for anywhere-access, though most individuals still save files locally. If you use SkyDrive, the account details will appear in the top left corner of all the application screens, as well as on their start screens. Click your account details to switch accounts and to manage them. When you save a document, worksheet or presentation, the application will default to saving to your SkyDrive account, but you can save to your local disk if you wish.
Syncing Across Devices

When you save your Office documents online, they'll be available to you (and others) from any device at any time, via Office 2013 on a PC or tablet, or via the WebApps. Microsoft has already upgraded the WebApps for Word, Excel, OneNote and PowerPoint with the new Modern-style look and Office application color coding. In addition, Word, Excel and PowerPoint will store the last location where you were working before you saved—down to the letter, cell or image. This feature makes it easier to pick up where you left off working, even if you open the file on a different device than you last used.
Touchscreen use

Word’s new Read Mode lets you scroll through the document by swiping horizontally with your finger. On a desktop with touchscreen monitor, you can change this behavior back to more traditional page navigation if you wish. Click the Touch Mode button on the Quick Access Toolbar -- to the right of the program logo of each application -- and the ribbon toolbar’s icons spread out for easier finger access.

Apart from these useful changes, however, touch integration in Office is somewhat erratic. You can use gestures such as tap, pinch, stretch, slide and swipe. But on a 24-inch touchscreen monitor, unfortunately, the text formatting icons were too small for me to use accurately. So, right now, though the suite is usable on a touchscreen device, it’s not yet touch-friendly.
PDF Editing

In the past you could save a Word document as a PDF file, but until now you couldn’t edit PDFs in Word without first converting them to Doc or DocX format. The new Word 2013 can open PDF files, edit them there and then save them as either DocX files or PDFs. When opened in Word, the file retains the structure of the PDF file, even for elements such as tables. This advance will be a big plus for many users, who can simply open a PDF and get straight to work.
Formatting Task Panes in PowerPoint

Formatting images, shapes and other objects in PowerPoint is now more intuitive. Right-click an image and choose Format Picture to open the new Format Picture task pane, which shows the formatting options available for that object. Click another object, and the options in the task pane change to show only the options available for that object. You can leave the pane open as you work, so that it’s visible without cluttering your workspace.
More Graphics Options

In Word, PowerPoint, Excel, Publisher and even Outlook, new icons on the Insert tab of the ribbon toolbar let you insert pictures from your local PC or from various online sources. The online options include inserting images within the Office Clipart collection online, via a Google or Bing search or from your own SkyDrive or Flickr account. (To access your Flickr account, you first need to authorize Office to connect to it.)
Easier Charting

For users confused by the plethora of charting options in previous versions of Excel, the new Recommended Charts feature is useful. Select the data to chart and click Insert > Recommended Chart to see options such as line, bar and pie charts that the program recommends for your data. Click each chart to preview what your data will look like in that form. After you select and create a chart, small icons will appear outside its top right corner when you select it, giving you access to work with chart elements, styles and colors, and with the chart data itself.
Account Login

The Backstage View in Office 2013 applications (accessed via the File tab) includes a new tab called Account (or ‘Office Account’ in Outlook). Here you can log in to your SkyDrive account or switch accounts. You can also see a list of connected services, such as Twitter and Facebook, and add services, such as LinkedIn and SkyDrive. The Office Updates area gives you information about the status of any available updates. Click Update Options to disable or enable updates and to view a history of Office 2013 updates.